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Was? Wozu? Warum?

* Endnote ist ein kostenpflichtiges Literaturverwaltungsprogramm, das Sie
hier bestellen konnen

* Sie konnen Dokumente jeglicher Art sammeln, ordnen und verwalten
* Generiert eine Literaturliste im entsprechend eingestellten Zitierstil
* Unter diesen Betriebssystemen nutzbar: Windows, MacOS

* Synchronisierung von Dateien und Daten -> ermdglicht Sicherung auf einem
Server und gemeinsames Arbeiten

* Gruppenfunktion fur die Arbeit im Team

* Sie promovieren an der UMG? Dann bendtigen Sie den UMG-Zitierstil fur
Endnote

* Bitte beachten Sie: dieses Selbstlerndokument bietet einen allerersten
Einstieg in die Basisfunktionen des Programms. Umfangreiche Hilfe und
Anleitungen bietet die Anbieterfirma Alfasoft, s.Tipps und Links im
Dokument
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https://www.endnote.de/
https://www.sub.uni-goettingen.de/lernen-lehren/wissenschaftlich-arbeiten-tools-und-techniken/literatur-verwalten/endnote/

Unterstutzung:

Online:
*‘Endnote-Tutorial-Kanal auf youtube

In der Endnote-Datenbank:
*‘Menupunkt ,,Help“ -> Endnote Training Portal

OpenClipart-Vectors- CCO

AuBerdem:
*Technischer Support uber Alfasoft
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https://www.youtube.com/user/EndNoteTraining
https://support.alfasoft.com/hc/de/categories/360000111937-EndNote
https://pixabay.com/de/hilfe-button-rot-notfall-153094/
https://creativecommons.org/publicdomain/zero/1.0/deed.de

Das Datenbankfenster

Linke Seite: ,My Library“: zeigt Untergruppen von Referenzen, dient zum Sortieren und
Organisieren

Mitte: zeigt bibliographische Daten in Spalten an

Rechte Seite: Metadatenbereich: Wahl zwischen Detailansicht einer Referenz, einer
Vorschau oder der Bearbeitung einer angehangten pdf-Datei

Bauer, 2016 #2134

1| e s
hutho Yem Titte Heterence |
2085 e, e alte Wt verieerit wisdt. Limgang e O EKD-Texte : 120 Book
Alter, | 206 Marc bevr Thess
Fat] Int Dinge. T Electrunic Bock
200 Whither systeims medicine] Expretientsl & wal.  Founal Anlicle

Inberdisoplinsry apginach fowards 3 syrems me Enefings in: ionnior._

Biskary, Chieta; | ackemune, fulia MAMTer K 2 Modeme Priegs heuse. Berut und Pralassion 2et Eachriar PRagesti

Bischer, Andreies Tiumenberg, Peis; K 2018 Erpertenstandar Besehungsgestatung in der P Schrifterrste dea 0. Doak
Genatric Medicl ch Collaboratse 2039 Inncwvations in g Fumne Healthe | fooenal Articie
Fhey, Gabisle; Schinsider, Flovian Daurma il 1] PlegiHmils - it Pllege Peiite Pk

Froese, KV, Wienie, A g [Legal guestxans m genatric medine-an arerie. HNCG foxenal Arhicie
Gromd, Erkch 04 Prieg menziranker. Imgubue i venrtsch, ook
Haarbrandt. Boger: Schvremwen, By e 2010 An Open Platioem Approach fo Enha._ Methods of mlormst..  fownal Aricle
Haa, Weymmang; Shen, Yaxing, Feng, Ming, Pl Asparin a3 in esapbageal cancer: 2 tnef roiew Journal of thoracic d.

Heuh, G 1 Inss 014 Dias spte Echis von K

Hasa, Hui: hang Hongying: Kong, Gingk. 2010 Meclicinal resoarch i

Innes, Anthes Bartholameyaik, Sakine 7014 Phlegelrsching: Dn..  flook
Jers, Inge Boak

o Prinr; Mintert, Marst; Gesley, Lndu & 2016 Scenific reports  Jouenal | Artico
Kamdje-Wabe, Gaetan: Gradinger, Tobin.. 2019 Towards Structused Dets Ousbty Assessment in t_ Stucdies in heafth tec.  fouwnal Artice

Bevor Sie starten, tragen Sie unter dem Menupunkt ,Edit* -> ,Preferences” -> ,Find Full Text" bei ,open url
path® den gbv-link ein:
https://sfx-49gbv.hosted.exlibrisgroup.com/sfx_sub
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https://creativecommons.org/licenses/by-nc-nd/3.0/

Los geht's:

U b U n g 1 : - OpenClipart-Vectors- CC0O

*Ubernehmen Sie mit den Suchwortern Demenz und Alter einige Treffer (11-
20) aus dem GUK in |hre Endnote-Datenbank

*Legen Sie fur diese Referenzen eine Custom Group an und sortieren die
Referenzen dort hinein

*Vergeben Sie fur einen Titel ein neues Schlagwort Ihrer Wahl

*Legen Sie eine Smart Group an, die auf der Suchanfrage basiert , Titel von
Gerald Huther aus dem Jahr 2015

*Starten Sie eine Suchanfrage mit den Suchwortern Hdither, Gerald im GUK,
ubernehmen Sie Treffer 1-30 in Ihre Endnote-Datenbank und beobachten Sie,
was passiert
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https://pixabay.com/de/eule-tier-vogel-computer-lustig-158414/
https://creativecommons.org/publicdomain/zero/1.0/deed.de

Losungen Ubung 1:

* Starten Sie den GUK, geben Sie Demenz und Alter ein und gehen auf S. 2 der Trefferliste. Klicken
Sie links im Feld auf Speichern und wahlen Sie unter Format Literaturverwaltung Endnote aus ->
Speichern

* Wahlen Sie in der Endnote-Datenbank den Menupunkt Groups -> Create Group und vergeben
einen Namen, z.B. Alterskrankheiten

* Markieren Sie alle Referenzen im mittleren Fenster. (Dazu eine Referenz anklicken, den
MenUpunkt edit auswahlen und select all anklicken). Mit drag and drop lassen sich die Referenzen
in die neue Custom Group verschieben (alternativ: Referenzen markieren, rechte Maustaste ->
Add References To -> neu angelegte Gruppe)

* Markieren Sie mit der linken Maustaste einen beliebigen Titel. Im rechten Feld sehen Sie unter
dem Reiter Edit die Datenbankfelder, die Endnote mit den dokumentbeschreibenden Angaben
(Metadaten) belegt. Scrollen Sie zum Feld Keywords, klicken hinter das letzte Schlagwort und
drucken die Return-Taste. Vergeben Sie ein Schlagwort Ihrer Wahl (z.B. Demenztherapie) und
speichern Sie (strg + s) oder klicken oben auf den Reiter ,save”.

Selbst eingegebene Schlagworter, Kommentare etc. konnen uber die Suchleiste in Endnote auch
wieder gesucht werden!

* Menu Groups -> Create Smart Group -> Name Hlither 2015
1.Suchfeld Autor Hiither, Gerald, 2.Suchfeld Year -> Textfeld 2015 -> Create

* Im GUK Suchanfrage Hiither, Gerald starten und Treffer 1-30 in Endnote Ubernehmen
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Weiter geht’s:

U.S. National Library of Medicine

Ubung 2:

*Suchen Sie in der Datenbank PubMed alle Artikel von Ulrich Sax und
ubernehmen Sie sie in Ihre Endnote-Datenbank

*Starten Sie mit Endnote die Volltextsuche

*Schauen Sie sich ein pdf an und setzen einen Kommentar

*Gehen Sie direkt mit Endnote in die Datenbank PubMed und starten eine
Suchanfrage mit Turner Syndrome Children

*Ubernehmen Sie die ersten 10 Referenzen in lhre Endnote-Datenbank

*In der ,Pharmazeutischen Zeitung Online” hat Annette Mende einen Artikel zu
Gicht und Fructose als moglichem Ausloser verfasst. Fugen Sie diese
Webseite/diesen Artikel Inrem Projekt hinzu
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https://www.ncbi.nlm.nih.gov/pubmed/

Losungen Ubung 2:

e Zuerst: Import Filter aktivieren! Menupunkt Tools -> Import Filters -> Open Filter Manager
Mit einem Kilick ins Kastchen den Filter PubMed NLM aktivieren

* Gehen Sie Uber das DBIS Infosystem (Homepage SUB -> Suchleiste -> DBIS) in die Datenbank
PubMed und geben Sie Sax, Ulrich ein. Klicken Sie auf send to, wahlen Citation Manager und die
Option all results aus. Dann klicken Sie auf -> Create File

* Markieren Sie einige der importierten Referenzen, klicken mit der rechten Maustaste darauf und
wahlen find full text

* Klicken Sie im mittleren Fenster auf eine Referenz mit einem PDF (der Key Takeaway generiert
lhnen sofort eine Kurzzusammenfassung des Dokuments). Offnen Sie das PDF mit einem Klick
auf das Pfeilsymbol in der Menduleiste, dann konnen Sie das Dokument bearbeiten. Sie kdnnen
jetzt z.B. Kommentare setzen, Unterstreichungen und Hervorhebungen vornehmen usw.
Speichern hinterher nicht vergessen!

*  Zuerst: Connection File aktivieren! Menupunkt Tools -> Connection File -> Open Connection
Manager -> mit einen Klick ins Kastchen PubMed NLM aktivieren

*  Wahlen Sie bei Endnote unter Online Search Mode PubMed aus. Starten Sie eine Suchanfrage
mit any fields und den Suchwortern Turner Syndrome Children. Markieren Sie die ersten 5 Treffer
und klicken Sie auf das +-Symbol oben rechts. Damit importieren Sie die Treffer in Ihr Endnote.
Sie finden sie unter der Ablage recently added.
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Losungen Ubung 2 - Fortsetzung

* Starten Sie mit Google eine Suchanfrage mit Mende Gicht Fructose und wahlen den passenden
Treffer aus
Klicken Sie in Endnote den Button New Reference in der Symbolleiste und geben in der

Eingabemaske alles ein, was Sie der Website entnehmen kdnnen (vor allem url! Aulerdem
empfiehlt es sich, auf Dokumenttyp journal article umzustellen um die Felder entsprechend

auszufullen)
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Fast geschafft!

Ubung 3:

*Schreiben Sie ein paar Satze in Word

*Flgen Sie an mehreren beliebigen Textstellen Zitationen ein (Buch,
Zeitschriftenartikel)

*Wechseln Sie den Zitationsstil und beobachten die Veranderungen

°| assen Sie sich von Endnote ein Literaturverzeichnis erstellen

*

|

N

3dman_eu - CCO

\
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https://pixabay.com/de/stift-kuli-schreiben-1020006/
https://creativecommons.org/publicdomain/zero/1.0/deed.de

Losungen Ubung 3

(@]

mcmurryjulie - CC

*  Schreiben Sie ein paar Satze in Word

« Stellen Sie den Curser an die Textstelle, wo die erste Zitation eingeflugt werden soll, klicken auf
das Endnote-Symbol in Word und klicken Insert Citation

* Wahlen Sie sich in der Suchmaske Ihre Referenz aus, die zitiert werden soll und fugen Sie sie in
Ihr Word-Dokument ein

* Fugen Sie ein weiteres Zitat in Ihren Text ein und nutzen jetzt den Button Go fo Endnote in Word.
So kommen Sie in die Vollansicht Ihrer Endnote-Datenbank und konnen nun eine Referenz
auswahlen. Uber die Anfiihrungszeichen (Symbol oben rechts iber der Trefferliste) wird die
Zitation in Ihr Word-Dokument eingeflgt.

Das Literaturverzeichnis wird automatisch erstellt und immer aktualisiert!
* Wechseln Sie den Zitationsstil, indem Sie einen anderen in der Style-Suchleiste auswahlen

* Markieren Sie beliebige Referenzen in Ihrer Endnote-Datenbank und klicken mit der rechten
Maustaste darauf

* Wahlen Sie Copy formatted Reference und fugen es in ein leeres Word-Dokument ein -> so
konnen Sie mit Endnote eine Literaturliste mit beliebig ausgewahlten Referenzen erstellen
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https://pixabay.com/de/lims-laborinformations-1604450/
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Termlists — das Besondere I\

3dman_eu - CCO

*Termlists: ,Begriffslisten”, dienen zur Speicherung von Eintragen wie Keywords,
Autorennamen und Zeitschriftentiteln

— Mit der journal termlist wird im Literaturverzeichnis — je nach Zitierstil - der abgekurzte
Zeitschriftentitel ausgegeben anstelle des ausgeschriebenen

— Erganzen sich automatisch, sobald ein neuer Autorenname, Keyword oder Zeitschriftentitel
in die Datenbank eingegeben wird

— Termlists enthalten alle Autorennamen, Keywords und Zeitschriftentitel, die in der Endnote-
Datenbank vorkommen

*Erganzung der Journal Term List:

— Menu library -> define term list -> termlist journals auswahlen -> import list anklicken ->
medical auswahlen -> Offnen -> mit dem Reiter Terms Ansicht der aktualisierten Journal
Termlist (2 Spalten mit Titeln und Abklrzungen)

— Je nachdem, welcher Output Style nachher gewahlt wird, gibt Endnote entweder den
ausgeschriebenen Titel oder die Abkurzung einer Zeitschrift im Literaturverzeichnis aus
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https://pixabay.com/de/idee-antwort-erleuchtung-klugheit-1019808/
https://creativecommons.org/publicdomain/zero/1.0/deed.de

Die Online-Version: Endnote Web . f

3dman_eu- CCO

*Wichtig: zuerst eine Sicherungskopie Ihrer Endnote Library erstellen (Menu
file -> compress library, dort Optionen with file attachements und all references
in library auswahlen -> next -> Speicherort wahlen

*Registrieren Sie sich mit Ihrer email-Adresse und legen sich ein Konto an
*Sie haben Zugriff auf eine umfangreiche Online-Anleitung

*Mit EndnoteWeb kann man an jedem Rechner Referenzen importieren und
anschliel3end in die Desktop-Version Ubernehmen

*EndnoteWeb ermoglicht die Arbeit im Team

*Uber den Button sync in der Endnote-Datenbank kdnnen die Referenzen
Online und in der Desktop-Version synchronisiert werden

*Schauen Sie sich ein Webinar zum Thema Synchronisieren an
*PDF‘s und Custom Groups werden mit synchronisiert
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https://access.clarivate.com/login?app=endnote
http://www.screencast.com/t/rcZqvBvuZqJ
https://pixabay.com/de/laptop-lernen-schule-computer-1019763/
https://pixabay.com/de/laptop-lernen-schule-computer-1019763/
https://creativecommons.org/publicdomain/zero/1.0/deed.de

Noch Fragen? 1 NFO

3dman_eu- CC0O

*Tools und Techniken zum Wissenschaftlichen Arbeiten finden Sie auf der

Homepage der SUB
*Beratung zum Schreiben gibt es beim Schreiblabor der Universitat

*Auf Youtube gibt es eine umfangreiche Sammlung von Video-Tutorials zum
Thema Recherchestrategien und Literatursuche

*Informationen zur guten wissenschaftlichen Praxis finden Sie auf den Seiten
der Uni Gottingen

*Die Uni Gottingen hat Informationen zum Thema Plagiate zusammengestellt
*die UMG hat Richtlinien fur die auRere Form der Dissertation verfasst
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https://www.sub.uni-goettingen.de/lernen-lehren/wissenschaftlich-arbeiten-tools-und-techniken/
https://www.uni-goettingen.de/de/individuelle+schreibberatung/578710.html
https://www.youtube.com/@LOTSE-ULBMS
https://www.uni-goettingen.de/de/604506.html
https://www.uni-goettingen.de/de/566172.html
https://www.umg.eu/studium-lehre/promotion/informationen-fuer-promovendinnen/verfahrensablauf/verschriftlichung-der-arbeit/
https://pixabay.com/de/users/3dman_eu-1553824/
https://creativecommons.org/publicdomain/zero/1.0/deed.de

Wir sind online immer fur Sie da:
Bereichsbibliothek Medizin (BBM)

* Alle Angebote fur Medizinstudierende auf einen Blick

* Auf der SUB-Homepage finden Sie unsere online-Angebote
thematisch sortiert

7

*Kontakt: dhaerter@sub.uni-goettingen.de oder Tel.: 39-28394
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Viel Erfolg bei Ihren Projekten!
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SUB Gottingen

Sofern einzelne Inhalte nicht anders angegeben sind,
ist dieser Selbstlernkurs unter einer CC BY 4.0 Lizenz
veroffentlicht.

https://creativecommons.org/licenses/by/4.0/
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